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2 Disclaimer 

The actual version of this product (document) is available as is. TEC-IT declines all warranties 
which go beyond applicable rights. The licensee (or reader) bears all risks that might take place 
during the use of the system (the documentation). TEC-IT and its contractual partners cannot be 
penalized for direct and indirect damages or losses (this includes non-restrictive, damages through 
loss of revenues, constriction in the exercise of business, loss of business information or any kind of 
commercial loss), which is caused by use or inability to use the product (documentation), although 
the possibility of such damage was pointed out by TEC-IT. 

 

 
We reserve all rights to this document and the information contained therein. Reproduction, 
use or disclosure to third parties without express authority is strictly forbidden. 
 

 
Für dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte 
vor. Vervielfältigung, Bekanntgabe an Dritte oder Verwendung außerhalb des vereinbarten 
Zweckes sind nicht gestattet. 
 

© 1998-2017  
TEC-IT Datenverarbeitung GmbH  
Hans-Wagner-Str. 6 

A-4400 Austria  
t.: +43 (0)7252 72720  
f.: +43 (0)7252 72720 77  
http://www.tec-it.com 

 

http://www.tec-it.com/
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3 Introduction and Installation 

3.1 About 

TEC-IT’s BlueBooking is an application for checking-in event participants by means of barcodes or 
NFC/RFID tags. The identification attribute can be chosen freely but it has to be unique for the 
event and the member.  

BlueBooking offers the possibility to import member lists, print name badges for each attendant 
(with barcodes) and check the presence of each attendant by reading the name badges with 
barcode scanners. The booking data (attendant and check-in-time) can be exported and used in 
Microsoft

®
 Excel

®
 or other applications. 

3.2 Supported Operating Systems 

 Windows XP SP3 

 Windows Vista 

 Windows 7 

 Windows 8.* 

 Windows 10 

 Windows Server 2003 

 Windows Server 2008 and 2008 R2 

 Windows Server 2012 and 2012 R2 

Runs on 32 bit and 64 bit operating systems. 

3.3 Restrictions of the Demo Version 

► In the demo version attendants are sometimes not booked. 

► In order to get a license key for the full version (without demo restrictions), please order 
BlueBooking online on http://www.tec-it.com/order/Default.aspx. 

3.4 Installation 

3.4.1 Via Installation Program  

This is the preferred method of installing BlueBooking on Microsoft Windows operating systems. 
Start the installation by double-clicking the .msi file and follow the instructions of the installation 
assistant. BlueBooking is usually installed to the following directory:  

Directory Description 

C:\Programme\TEC-IT\BlueBook1 binary data, documentation 

C:\ProgramData\TEC-IT\BlueBook\1.5 templates, configuration file, participant information, … 

For installation, you need the so-called Installer for Microsoft Windows. If necessary, this software 
can be downloaded and installed from the following source: 

http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-

de776fd4138c&displaylang=en 

http://www.tec-it.com/en/order/Default.aspx
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
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3.4.2 Via ZIP File 

Follow these steps: 

1. Create an empty directory. 
It is important that you have the necessary writing permissions for this directory.  

2. Copy and unzip the ZIP file into this directory.  
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4 Starting the Program 

4.1 The Overview Window 

After starting BlueBooking, the overview window will appear: 

 
Figure 1: Overview Window 

This window gives an overview of booked participants and it shows the number of connected 
scanners. Furthermore, it provides a menu . 

Event Data  
Here you see some general information about the event. This data can be edited in the 
member list (see chapter 5). 

 Check-in counter  
 The following three values are shown: 

 Green: members who have already been checked-in 
 Red: members who have not been checked-in yet and  
 Dark grey: total number of members 

 If no member information has been imported, the member list is empty and the numbers will 
all show 0.  

 Additional information: Number of invalid scans  

(e.g., because of reading unknown barcodes or due to double bookings). 

Additional information: Number of configured respectively connected barcode scanners 

(see chapter 6.2). 

4.2 Schematic Workflow 

When using BlueBooking, you can distinguish three phases: 

1. In the preparation phase you configure the reading devices, import participant information 
and (optionally) print badges. 
More information can be found in chapters 5 and 6. 
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2. In the booking phase the participants will be checked in. BlueBooking registers the 
boarding time with a time stamp. 
The current booking data can be displayed in the list view.  
See chapter 7 for more information. 

3. In the evaluation phase, booking protocols can be exported. This can be used for further 
evaluation. 
See chapter 8 for more information. 

 

► You can contact us if you face any problems configuring the application. We would be happy 
to support you.  
If needed, TEC-IT also delivers the application preconfigured. 

4.3 Automated Connection 

Right after starting the program, BlueBooking tries to establish a connection with the reading 
devices or smartphones. If no reading devices are configured, you can configure them at any time 
(see chapter 6). 

If no participant data is available, the software will ask you to import this data. Instructions on how to 
import participant data is described in chapter 5. 

4.4 Data Storage 

BlueBooking automatically stores the configuration and application data. 

On every change, the most recent data is saved automatically. This is the event title, the participant 
list, the check-in counter and the reading devices (including their settings). When starting the 
program for the next time the state of the last session is restored. 

Please note that you can adjust a time interval for saving the participant list in the configuration file. 
This interval guarantees a minimum delay between two save operations. It helps to improve the 
performance for large member lists and high booking frequencies. 
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5 Member List 

5.1 Import Member List 

Important: 

► Before importing a new list of members, make sure you have exported the booking infor-
mation of the previous event.  
The current booking data is irretrievably overwritten on importing new data. 

To import a member list, go to the menu and choose File ► Import Members…. 
Then, select the import file and click OK. After successfully importing the file, the counters and the 
list view in BlueBooking are updated accordingly. 

5.2 View Member List 

The tab “Members” shows the loaded member list with the respective booking data. Additional 

functions allow you to edit single list items (Add, Edit, Check-in …). 

In the header you specify characteristics for the event, and you select the booking mode. 

 
Figure 2: Member List 

Event data  
Enter information about your event here. This data is only for your own information (see also 
Figure 1, ) 

Check-in counter  
 The following three values are shown: 

 Green: members who have already been checked-in 
 Red: members who have not been checked-in yet and  
 Dark grey: total number of members 

 Member list  
The members are shown in different colors depending on their check-in statuses. In the 
beginning, all members are shown in red. After a successfully check-in, the corresponding 
line is updated to green. After checking out, the color changes to dark red. 
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Booking behavior  
This setting specifies which bookings are recorded for each member: 

 Check-In only 
 Single Check-In/ Check-Out 
 Multiple Check-In/ Check-Out  

(Tip: Previous durations of attendance can be seen in the detail mask of the member.) 

Filter 
You can search the member list for a specific text. All lines that contain the searched text are 
shown. 

Edit member data 

 New 
With this function you can add new members (e.g. to collect data of walk-ins).  

 Edit 
With this function you can change existing member data. You can quickly access this 
function by double-clicking the respective entry or by pressing the function key F2. 

Edit check-in status 

 Check-in / check-out 
With this function you can manually check the selected member in or out. You can quickly 
access this function by pressing the function key F10. 

 Cancel 
This function cancels the previous booking for the selected member. You can access this 
function by pressing the function key F11. 

Name Badge  
Allows you to reprint name badges for the selected member. Just like the function “Print all 
name badges” (see section 5.5), this function is only available if you have installed the 
commercial software TFORMer Designer.  

5.3 Structure of Member Files 

BlueBooking imports member data from a text file. When you create a file, please make sure to 

include the following columns: 

 ID, 

 First Name, 

 Last Name, and 

 Company 

The column ID is used to identify the members and has to be encoded in the member’s barcode or 
on the NFC/RFID badge. This column cannot be empty and has to contain a unique member-ID 
(for example the member’s e-mail address).  

The columns First Name, Last Name and Company are used for the (optional) printing of name 
badges.  

If the import file contains more columns in addition to the required ones, BlueBooking will display 
them unmodified in the member list. 

5.4 Preparation of the Member File in Microsoft Excel 

If you prepare a member file in Microsoft Excel, save the member list as Unicode Text (file 
extension .txt). The file might not be imported correctly or the name badges might not be printed 
correctly if it is saved under a different format.  
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5.5 QR-Code Badges 

QR-Code badges for the imported members can be printed by clicking File ► Print All Name 
Badges in the menu.  

Important: 

► In order to use this function, TFORMer Designer (commercial software by TEC-IT) has to 

be installed.  

Participant badges can also be created with any other suitable software. However, it is important 
that the value from the column ID is used as unique identification attribute. 

 
Figure 3: Printing Name Badges with TFORMer Designer 
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6 Configuration of Reading Devices 

6.1 General 

The application BlueBooking can be used with numerous stationary and mobile barcode scanners 
respectively NFC/RFID reading devices with different interfaces. It is also possible to use Android 
smartphones as reading devices. 

6.2 Scanner List 

The tab “Scanners” shows the configured scanners. Scanners can be added, edited or deleted. 

 
Figure 4: Scanner List 

Scanner list  
Shows all configured scanners. The connection statuses of the respective devices are 
shown in different colors: 

 Green: connected, 
 Red: not connected, 
 Dark red: connection establishment and 
 Grey: inactive.  

Lock or unlock the current configuration  
When adding/editing a new scanner all existing connections to the configured scanners are 
disconnected automatically. In order to avoid unintentional interruptions during the ongoing 
operation BlueBooking will lock the current configuration upon program start by default. 

 Editing functions  
Use this function to add, edit or delete scanners. 

6.3 Scanner Configuration 

The following dialog window will appear when you try to add or edit scanners.  
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Figure 5: Scanner Configuration 

Load Predefined Settings  
Here you can load pre-defined scanner settings (see chapter 6.5). 

Name 
An arbitrary name. This name will be displayed in the scanner list. 

Enable or disable device  
A connection can only be established if the scanner is enabled. 

 Connection settings  
The connection settings are divided into: 

 Interface (the interface type and its corresponding connection settings), 
 Read Policies (which data is considered a reading?) and 
 Timeouts (e.g. for establishing a connection). 

6.4 Supported Interfaces 

Please make sure that the scanners are configured correctly for the respective connection and that 
all necessary drivers are installed on your computer: 

Physical 
Interface 

Transmission Interface 
(Option in BlueBooking) 

Comments 

Serial (RS-232) Serial Interface Use the same connection parameters on your scanner and in 
BlueBooking (baud rate, data bits, stop bits, parity …). 

Bluetooth Serial Interface Before using a Bluetooth-Scanner in BlueBooking, it has to be 
paired with the respective computer (see Appendix C). 

Make sure, the “Serial Port Profile” (SPP) is activated on the 
scanner. 

In BlueBooking the data can be received either via the “serial 
interface” or via “Bluetooth”. We recommend using “Bluetooth” 
because connection parameters for the virtual COM interface 
(baud rate, data bits, stop bits, parity …) are automatically 
matched.  

Bluetooth 
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Networks 
(LAN, WLAN …) 

TCP Client BlueBooking acts as TCP client. The scanner has to be 
configured as server. 

Assign a fixed IP address to the scanner (= the server).  

TCP Server BlueBooking acts as TCP server. The scanner has to be 
configured as client. 

Assign a fixed IP address to the server. 

USB Serial Interface Most of the USB scanners can be connected through a virtual 
COM Port (VCP). 

This operating mode has to be configured on the scanner once. 

On the PC, appropriate drivers are required. 

HID Keyboard Many scanners can also be operated in a HID Keyboard mode. 
This means that the scanner registers in the operating system as 
a keyboard and the scanned data is simulated as appropriate key-
strokes. 

This operating mode has to be configured on the scanner once. 

Be aware of setting the correct language when configuring the 
scanner (e.g., English keyboard layout). 

6.5 Predefined Scanners 

BlueBooking is delivered with templates for the following scanners: 

 Android Wireless Barcode Scanner 
This app for Android decodes bar codes with the in-built smartphone camera and transfers 
the barcode to BlueBooking via Bluetooth. 

 Baracoda D-Fly2 

 Datalogic Magellan 1100i 

 Koamtac KDC300 

 Motorola Symbol CS3070 

Please note that these templates may include settings that are not available in the configuration 
dialog (see Figure 5). For example, the file “settings KOAMTAC KDC300.xml” defines additional 
control commands, which are used to transfer responses to the scanner (display, texts, scanner 
beep). 
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7 Check-In 

7.1 Automatic Start 

BlueBooking tries to establish a connection with the configured (and active) scanners right after 

starting the program. As soon as the connection is established, the members can be booked. 

► If there were connection problems, you can identify the device in question via the scanner 
list (see chapter 6.2). Appendix A might help you to find possible problems. 

7.2 Booking Members 

To book a member, the barcode (or the NFC/RFID tag that is assigned to the member) must be 
read with a scanner or a smartphone. If a member has been booked successfully, the overview list 
displays the entry in green color and the member counters are updated accordingly. 

Every booking is saved immediately. BlueBooking can be closed or re-started anytime without 

losing any data. 

7.3 Display on the Scanner 

If your device supports this function, a feedback can be shown on the display of your scanner or 
smartphone. The BlueBooking configuration might have to be adjusted manually (see Appendix 

D).  

Example: In the default setting for KOAMTAC KDC300, a welcome text is shown on the display 
after successfully establishing the connection. When reading a barcode, you will hear an acoustic 
signal and one of the following texts is displayed: 

 Check-In OK: The member was successfully checked-in. 

 Unknown: The member is unknown. Try to scan the bar code once again to make sure this 
message did not come up because of a reading problem. 

 Already booked: The member has already been booked for this event. 

If the connection is interrupted (e.g., the scanner is not within reach of the Bluetooth signal of 
approximately 10 meters), BlueBooking tries to re-establish the connection on its own.  

► If the connection was interrupted, NO confirmation of the booking will be shown on the 
scanner! Press the scan button on the scanner and wait until BlueBooking has re-

established the connection.  
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8 Evaluation 

8.1 Export Booking Data 

A further evaluation of the check-in data is possible, for instance, in Microsoft Excel. Go to the menu 
and choose File ► Export Members… to export the data as CSV-file. The created CSV file 
corresponds to the originally imported member file, including additional columns for the acquired 
booking information (time, scanner name). 

Members who took part in the event are marked with a time stamp (check-in time). If there is no 
time stamp available, the member did not get booked (no-show).  
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9 Licensing 

9.1 License Types 

Please check out http://www.tec-it.com/order/Default.aspx for available license types and pricing. 

9.2 Entering your License Data 

To enter your license data, select Help ► License… from the menu. The dialog below will appear. 
BlueBooking provides two methods for entering the license data: 

 Online activation using the Activation Key (see section 9.2.1). 
This is the default method. Internet access is required. 

 Manual licensing (see section 9.2.2). 
Please get in touch with us if your system has no internet access or if you prefer to use the 
manual activation for any other reason. We will be glad to send you the license data, which 
is suitable for manual licensing. 

9.2.1 Online Activation using the Activation Key 

If you received an activation key from TEC-IT, please use the online activation . 

 
Figure 6: License Dialog - Online Activation 

The following steps are required to license the product: 

1. In field  enter the activation key. 

2. In field  enter your email address. A license certificate will be sent to this address 
automatically. 

3. Complete all remaining data (Company, Country, ZIP Code, City). For a successful 
activation, all fields are required. 

4. Confirm your input by clicking Send. 

A message will inform you about the successful activation. In case of problems or errors, please 
contact TEC-IT. 







http://www.tec-it.com/order/Default.aspx
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9.2.2 Manual Licensing 

Manual licensing is the alternative method for licensing if your system has no internet connection. 
Select manual licensing  and enter the license data as provided by TEC-IT.  

► Please enter the license data exactly as you received it from TEC-IT!   
Spacing and upper/lower case letters are to be considered. To avoid typographical errors, 
please insert the data using “copy and paste” from the email containing your license data 
whenever possible. 

► Single licenses  
If you purchased a single (workstation) license, you need to provide the so-called “System 
ID” (or hostname on LINUX and MAC) of the target computer. You can find the System ID 
(or hostname) in the licensing dialog (see below). 

 

 
Figure 7: License Dialog - Manual Licensing 

The following steps are required to license the product: 

1. On the top of the dialog you find the System ID
1
 () of your computer. 

For single licenses, we will ask you to send us the System ID of the target machine. 

2. In the the field “Product” select “BlueBooking”. 

3. In the field “Licensee” enter the name of the license holder. 

4. In the field “Kind of License” select the kind of license that you have purchased. Possible 
license types are: 

 Single  
 Site 
 Enterprise 

5. In the field “Number of Licenses” enter the number of licenses that you have purchased. 

6. In the field “Your License-Key” enter the license key exactly as received from TEC-IT. 

7. Confirm the dialog with OK. 

A message will inform you about the successful activation. In case of problems or errors, please 
contact TEC-IT. 

                                                                 
1
 On UNIX, Linux or Mac OS X the hostname of the system is used as System ID (relevant only for Single licenses) 
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9.3 Temporary Test Licenses 

For a restricted period of 10 days, you have the possibility to gain a temporary, but otherwise 
unrestricted test license. You can request this temporary test license only once.  

When opening BlueBooking you see a dialog, which allows you to request a test license online.  

 
Figure 8: Request a Test License 

Click the button Yes, activate my free test license…. The license data is transmitted automatically. 

In case of an error, please contact TEC-IT. 

 
Figure 9: Demo Version Unlocked 

If your test license has been successfully activated, you are informed about the remaining test 
period with every application start.  
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10 Contact and Support Information 

TEC-IT Datenverarbeitung GmbH 

Address: Hans-Wagner-Str. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: mailto:support@tec-it.com 

Web: http://www.tec-it.com 
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Appendix A: Troubleshooting 

A.1 Connection to Scanner Cannot Be Established 

If BlueBooking does not automatically connect to all scanners after the software was started, 

please check the following: 

 The scanners must be turned on and active (= not in stand-by). 
Press the scan-button on the scanner to activate it.  

 The scanners must be configured correctly.  
(e.g., special connection settings for Bluetooth scanners – see Appendix E) 

 Bluetooth scanners must be set up correctly on your computer. 
(Pairing necessary – see Appendix C) 

 For TCP connections make sure to set up your firewall accordingly. 

 Mobile scanners (Bluetooth, WLAN) have to be within reach of your computer (maximum 
distance of 10 meters for Bluetooth!). 

 Mobile scanners (Bluetooth, WLAN) must be sufficiently charged. 
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Appendix B: Command Line Parameters 

B.1 Debug Mode 

For testing purposes, BlueBooking can be started in debug-mode by entering the command line 
parameter debug. A log-file will be created in the configuration directory. This file can be consulted 

for identifying problems. 

B.2 Beep on Error 

By entering the command line parameter beeponerror the PC will play an audio signal for invalid 

scans. 
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Appendix C: Bluetooth Pairing  

C.1 General 

In order to use a Bluetooth device with BlueBooking, it has to be paired with your computer before-

hand. 

Turn on the pairing mode of your scanner (for instance, on the KOAMTAC KDC300 push both the 
up and down button and activate paring in the menu BT Service). Afterwards, add a new Bluetooth 
device in Microsoft Windows. The exact steps for this depend on your Windows-Version and the 
Bluetooth stack. Example screenshots for Windows 7 are shown below: 

C.2 Add A Device 

Search active Bluetooth devices on your computer. All found devices are shown in a list (see 
below). Please make sure that the scanner is in pairing mode.  

 
Figure 10: Add New Bluetooth Device 

C.3 Pairing Option 

The next step is to choose the pairing option. 

For the KOAMTAC KDC300 choose, for instance, pairing without PIN (without security code). The 
scanner has to be configured for mode SPP 2.0 (see Appendix E).  
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Figure 11: Pairing with a Bluetooth Device 

C.4 Pairing Successful 

Microsoft Windows will let you know if pairing was successful and will then install the necessary 
drivers automatically.  

 
Figure 12: Successful Pairing with a New Bluetooth Device 

C.5 Checking the Scanner Installation 

By right clicking the Bluetooth scanner, the properties will appear and you can check if your scanner 
has been installed correctly. If you switch to the tab “Services”, a serial port must be shown for the 
scanner. 



 
 
 

Seite 25 von 30 

 

BlueBooking  
User Manual  

 
Figure 13: Check Pairing with Bluetooth Device (Bluetooth SPP) 

► If there are any problems, make sure that the system software of the manufacturer is NOT 
installed. It is possible that the system software blocks the usage of the scanner through 
Bluetooth SPP. 
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Appendix D: Configuration 

D.1 Configuration File Config.xml 

The BlueBooking configuration is stored in the file config.xml. This file contains the following 

settings: 

 Barcode-Scanners 
A list of all scanners and their settings (e.g., connection settings or, if supported, the 
feedback which should be shown on the scanner display). 

 Description of the Member-Data 
Specifies, for instance, the format of the import file. 

For a thorough description of the configuration file including all standard values, please refer to the 
file config_description.xml. This file can be found in the Windows start menu folder for 
BlueBooking under Documentation ► Technical Documentation. 

Important! Please note: 

► Manual changes of the configuration file can affect the functioning of BlueBooking. 
Therefore, changes should only be carried out by trained staff. 

► Changes to the file config.xml must always be made before starting the application. 

► Manual changes to the configuration file are only necessary if you want to change definitions 
for the import file or if you want to edit control commands for the scanner (display texts, 
scanner beep). 

► The basic scanner settings can and should be configured via the according dialogs inside 
the application. 

D.2 Scanner 

All scanner settings can and should be changed directly in the application (see chapter 6).  

Editing the XML file manually is only necessary if you want to define special control commands for a 
scanner (like the feedback for successful/unsuccessful scans or for multiple bookings). Such 
commands cannot be edited on the dialog and manual changes to the configuration file will have to 
be made. 

D.3 Import File 

The configuration file defines the column names and separators for the import file.  

The following settings are essential: 

 The name of the column that contains the unique member ID. 
(Attribute colBarcodeId; the default setting is ID) 

 The name of the column that stores the check-in-time of the member. 
(Attribute colCheckIn; the default setting is Check-In) 

 The name of the column that stores the scanner, with which the booking was acquired. 
(Attribute colCheckInScanner; the default setting is Check-In Scanner) 

 The field separator that is used in the import file. 
(Attribute fieldSeparator; the default setting is \t (tab)) 
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For the import file, please consider the following: 

► The import file must be a text file with character-separated values (*.csv, *.tsv …). The data 
rows have to be separated by line breaks. The columns must be separated by the pre-
configured field separator. The first row must contain the column names. 

► The column with the barcode IDs is mandatory. The columns for check-in time and scanner 
are optional and will be added automatically where required.  
The names of these columns must match the configuration file. 
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Appendix E: KOAMTAC KDC300 Configuration 

E.1 Example Configuration 

Below you will find an example configuration and the necessary settings for the 2D Bluetooth 
barcode scanner KOAMTAC KDC300, representative for other Bluetooth scanners. The Bluetooth 
configuration has to correspond to the values stated below (especially SPP 2.0, AutoPowerOn, 
WedgeOnly). The barcode configuration (accepted barcode types) can be adapted to individual 
requirements:  

KDC-Mode            ................  Normal  

View Data           ................  Standard values 

Set Barcodes        ................  Standard values 

Code Options        ................  Standard values 

Scan Options        ................  Standard values 

Data Process     

  Wedge/Store       ................  Wedge Only (*) 

  Data Format       ................  Barcode Only 

  Data Editor       ................  Standard values 

  Handshake         ................  Disabled 

  Terminator        ................  CR+LF (see config.xml) 

  Chk. Duplicate    ................  Disabled 

   

BT Config 

  ConnectDevice     ................  SPP 2.0 

  Auto Connect      ................  Disabled 

  Auto Power On     ................  Enabled (*) 

  PWR On Time       ................  Disabled 

  Auto Power Off    ................  Enabled 

  Beep Warning      ................  Enabled 

  PWR Off Time      ................  5 minute(s) 

  PowerOff Msg      ................  Enabled (*) 

  Wakeup Nulls      ................  Disabled 

  MAC Address       ................  Standard values 

  FW Version        ................  Standard values 

  Wakeup Nulls      ................  Disabled 

  BT Toggle         ................  Disabled (*)  

  All HID Settings  ................  Standard values 

 

BT Service 

  Power             ................  Enabled 

  Pairing           ................  see Appendix C 

  All other settings are not relevant or standard values 

   

System Config 

  Beep Volume       ................  Low (*) 

  Brightness        ................  4 (*) 

  All other settings are not relevant or standard values 

 

(*) … These settings have to be edited manually during the configuring of the scanner. All 

other settings comply with the factory settings.  
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Appendix F: Additional Information about Device 
Interfaces 

F.1 HID Keyboard 

The device interface “HID keyboard” is intended for barcode scanners, which are operating in the 
HID keyboard mode (which means they provide the data as keystrokes just like a keyboard). 

Please note: 

When using this connection type you may experience problems in conjunction with the keys 
Shift, Ctrl, Alt and Win. This is due to the nature of the internal implementation and may probably 
not be fixed. Nevertheless, we would ask you to contact us with the details if you are facing 
problems. 

Key combinations such as Ctrl+Alt+Del, Alt+Tab and Alt+Esc will always remain fully functional 
(also if the option “Block Keystrokes” is enabled). 

The following problems are known: 

F.1.1 Mark Text Passages in Microsoft Word 

If you want to mark a text passage in Microsoft Word by pressing Shift+Left/Right you will notice a 
delay for the Shift key (e.g., the first character is not included in the selection). 

Solution: 

 There is no known solution for this problem. 

F.1.2 Block Keyboard Input 

If the keyboard is selected as capturing device and “Suppress keystrokes” is enabled, you will block 
all input from that keyboard. Only a few specific Windows keyboard shortcuts remain functional 
(such as Ctrl+Alt+Del, Alt+Tab and Alt+Esc). The operating system ensures the operation of these 
shortcuts. 

Known issues for blocked keyboards: 

F.1.2.1 Application Switcher (Alt+Tab) 

The application switcher will not close when releasing the Alt+Tab key combination. 

Solution: 

 Try to press the Alt key again or use the mouse to click on the window to which you would 
like to switch. 

F.1.3 Windows 10 Touch Keyboard 

The Windows 10 Touch Keyboard (TabTip.exe) does not send Shift+Key combinations correctly 
(e.g., ‘a’ instead of ‘A’). 

Solution: 

 Use the “On-Screen Keyboard” instead. 



 
 
 

Seite 30 von 30 

 

BlueBooking  
User Manual  

F.1.4 Remote Desktop 

The option “Block Keystrokes” does not work inside a Remote Desktop window. Besides that, 
BlueBooking does not capture any input if the remote Remote Desktop has the focus.  

Solution: 

 Open the Remote Desktop Connection options, switch to the tab “Local Resources” and 
change the keyboard setting “Apply Windows key combinations” to “On this computer” (see 
Figure 14, ). 

 When using the default setting “Only when using the full screen” the data capturing works in 
windowed mode only (not in full-screen). 

 

 
Figure 14: Remote Desktop Settings for Keyboard Scanners 




